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======================================== 

Safety Warning 
 
ACR-View is a development tool for creating programs that control your system's electrical and mechanical 
components. Therefore, you should test your system for safety under all potential conditions. Failure to do so can 
result in damage to equipment and/or serious injury to personnel. 
 
 
======================================== 

Revision 6.3.3 (1/31/14) 
• Updated license for IEC PLC functionality 
• Fixed miscellaneous bug 

- AV-1339 - fixed crash when opening some projects created in 5.3.0 
- AV-1358 - fixed a problem with memory allocation for PROG15 for AR-CE 
- AV-1663 - fixed a problem where deleting an IEC variable makes the variable name unusable  
- AV-1691 - fixed a problem where Find function could not search in up direction 
- AV-1692 - fixed a problem where tag export was not ignoring constants 
- AV-1694 - fixed a problem where tag export data types were wrong 
- AV-1695 - fixed memory leak with GetACRMemory()  
- AV-1698 - fixed a problem where installation on Win 7 would place files in the c: directory 
- AV-1701 - changed the name of the Ion stepper drive to P2 
- AV-1706 - fixed a problem where MPP/MPJ motors with 6S or 9S were being identified as a linear 

motor 
- AV-1707 - fixed a problem where OS downloads were falsely blocked 
- AV-1708 - fixed a problem where saving the project causes the editor to scroll all the way to the 

beginning 
- AV-1710- fixed resolution of MPP/MPJ motors with 6S and 9S feedback 
 - fixed resolution of SMN motors with 5D feedback 
 

 
Revision 6.3.2 (1/31/13) 

• Updated license for IEC PLC functionality 
• Added features 

- AV-1362 - modified AriesCE OS download procedure to automatically do FLASH RES 
- AV-1681 - added option to Export Tags that allows the export of IEC direct access Variables that 

can be imported into Xpress projects 
- AV-1685 - updated IEC library to ver 1.02 

• Fixed miscellaneous bug 
- AV-1364 - fixed a problem that causes a crash when the Oscilloscope timebase was set too high 



 
Revision 6.3.1 (12/14/12) 

• Fixed miscellaneous bug 
- AV-1678 - fixed a problem that causes the user interface and communications to lock up for 100 

seconds 

 
Revision 6.3.0 (10/22/12) 

• Added features 
- FB334 - added labels for EPL Input 7 
- FB725 - added code to the error message for Error during Configuration downloads 
- FB794  - added toolbar button to hide IEC docking windows 
- FB1303 - added Senary Axis Flags to Bit Status Panel 
- FB1380 - added ability to set Positive Software Limit to a negative number 
- FB1414 - added a button to show/hide Message Window that will have an alert symbol if there is 

an error while the Message Window is hidden 
- FB1532 - added support for the CANOpen Analog I/O in Numeric Status Panel 
- FB1562 - added SMN 5D motor to Compax3 EPL configuration 
- FB1604 - added IEC functions DINT_TO_TIME and TIME_TO_DINT 

 
• Fixed miscellaneous bugs 

- FB543 - fixed text in Servo Loop Status Panel 
- FB1041 - fixed a problem with the EPLD parameters in the Numeric Status Panel and Parameter 

picker 
- FB1179 - fixed a problem where Configuration wizard generated extra code for the wrong 

product 
- FB1268 - fixed a problem where uploads of Defines were getting corrupted through Serial 
- FB1275 - fixed a problem where controller was getting stuck in TalkTo mode after a failed OS 

Update to Aries PE drives 
- FB1310 - fixed a problem with some IEC Function Blocks missing their help files 
- FB1331 - fixed a problem where Uploads and Download of IEC project causes a crash 
- FB1332 - fixes a problem where IEC Uploads would not update an IEC file if it was open 
- FB1333 - fixed a problem where IEC Uploads may fail if the controller was Online 
- FB1337 - fixed a problem in ComAcrServer where SetAcrMemory of more than 2048 elements 

throws a runtime exception 
- FB1360 - fixed a problem where a space at the end of a DEFINE statement excludes the variable 

from the Tag Export list 
- FB1362 - fixed a problem in ComAcrServer where binary Move commands were not working in 

Serial communication 
- FB1378 - fixed a problem where the Find Next button in the Find dialog closes the dialog 
- FB1383 - fixed a problem where the Strip Chart was only graphing 5 seconds worth of data 
- FB1386 - fixed a problem where DriveTalk does not close properly when using Serial  
- FB1405 - fixed a problem where opening older projects may crash 
- FB1411 - fixed a problem with the Toolbar buttons being enabled while not connected to the 

controller 
- FB1417 - fixed a problem where some menu function would disable after an IEC Project upload 
- FB1420 - fixed a problem where the default status update rate was too slow 
- FB1423 - fixed a problem with the organization of the Bit Status Panel 
- FB1425 - fixed a problem where ACR-View could freeze up when connection to controller was 

lost 
- FB1435 - fixed a problem where some of the IEC item on the Toolbar did not have a tooltip 
- FB1457 - fixed a problem where an interrupted IEC Upload leaves the toolbar and menu disabled 
- FB1606 - fixed a problem with how the Program Editor handles <LF> character that are not part 

of a <LF><CR> 
- FB1657 - fixed a problem with Numeric Status Panel and the organization of the EPL parameters 



- FB1695 - fixed a problem in IEC-PLC with direct variables not being processed properly when a 
program is compiled for speed or normal 

- FB1772 - fixed a problem with Servo Gains and Jog/Home/Limits dialogs were not attaching 
encoders properly if separate velocity feedback device was used 

- FB1793 - fixed a problem with ENC LIMIT not getting set properly 
- FB1868 - fixed a problem where the font size was too small when printing a Program Editor 

 
Revision 6.2.2 (2/23/12) 

• Fixed miscellaneous bugs Fixed 
  - FB1546    -IEC - Check syntax crashes 
 

Revision 6.2.1 (2/6/12) 
• Updated license for IEC PLC functionality 
 

Revision 6.2.0 (9/15/11) 
• Added features 

- FB335 - added functionality to save and backup project 
- FB366 - re-downloading of IEC project no longer necessary after an upload 
- FB478 - IEC_PLC directories are now named <projectname>_IEC_PLC.  This allows libraries 

to have unique names so that multiple user defined libraries can be imported and used 
- FB576 - Bit Status Panel now retains the axis selection for axis specific selection 
- FB597  - added print functionality to Configuration Wizard->System Code 
- FB639 - added docking panel for IEC PLC status and controls 
- FB682  - added restriction to 26 characters for Other Motor->Part Number for AR-CE and Aries 

EPL configuration 
- FB732  - added a menu item Change Return Type for IEC functions. 
- FB765  - added EPL SDO object parameters 
- FB783  - added assigned master to the IEC global file Axes.poe. 
- FB785  - enabled Replace and Select All Edit menu items for IEC file types 
- FB897  - updated IEC Library to version 1.01 
- FB931  - updated the Aries Motor Database to include MPP motors with 7D option and SME 

motor series 
- FB937  - increased robustness of AR-CE OS updates 
- FB943 - upload project for 96x0 controllers now include IEC PLC upload 
- FB946 - added new signed USB drivers 
- FB948 - added “Read Only” note to Axes.poe to ensure that users do not tamper with the file 
- FB972  - ACR-View now requires .Net Framework 1.1 or 3.5+ 
- FB1013  - updated ACRViewMotorDatabase to include Parker Ion stepper drive support 
- FB1037  - added document type to the title of IEC dialogs 
- FB1136  - increased robustness of the Jog/Home/Limits dialog 
- FB1170  - increased robustness of the Ping method used for connections 
- FB1247  - increased robustness of the OS Update by automatically closing the Common Status 

Panel 
 

• Fixed miscellaneous bugs 
- FB22 - fixed a problem with the EPL configuration dialog where Period was calculating 

improper values for 9630 and 9640 
- FB408 - fixed a problem where IEC files that are renamed lose their marked as unsaved status if 

they are unsaved 
- FB409 - fixed a problem where Scaling wizard applies the wrong scaling factor for axes that are 

added to a master after the initial setup 
- FB463 - fixed a problem where default unassigned value for a real IEC variable and parameter is 

1.0 instead of 0.0 
- FB481 - fixed a problem where after an OS Update, downloading IEC project could cause a 



saving persistence failed error 
- FB604  - fixed problem where the Configuration Wizard would set Period=0. 
- FB641  - fixed a problem IEC variables are not recognized after being declared by the declaration 

editor. 
- FB701  - fixed a problem where USB connection shows as Ethernet. 
- FB702  - fixed problem where DIM DEF was not being generated if Number of Defines = 0. 
- FB727  - fixed a problem with storing the User Defined Part Number for Other motors in .ast 

files. 
- FB728  - fixed a problem with the display of the .ast file path after Import Configuration from file 

being cut off and unreadable. 
- FB730  - removed unsupported I/O Mapping IEC file type 
- FB731  - removed infoTeam logo from project cross reference template. 
- FB736  - filtered out resolver motors from AR-CE and AriesEPL configuration. 
- FB753  - fixed IEC bit status panel labels. 
- FB766  - fixed a problem where AR-CE was left in Echo6 mode after project upload. 
- FB775  - fixed default for download when IEC dialogs have focus. 
- FB781  - changed default P option for ACR9000 controller to P1. 
- FB782  - fixed problem where Scaling Wizard was not initializing properly. 
- FB789  - fixed a problem to removes white space indicators before saving. 
- FB814  - modified ST and LDD function block template to include VAR_IN_OUT declaration. 
- FB818 - fixed a problem where passive Terminal activity (ie Print statements in a program) 

causes the Terminal to have focus 
- FB828  - fixed a problem with uploading older configurations from ACR-View 5.5.5 
- FB844 - fixed problem in IEC PLC where all source files are not downloaded after a change 
- FB845  - fixed a problem where changing motors would reset the scaling dialog. 
- FB846  - fixed problem where the Connection dialog would open when Jog/Teach panels and 

Common status panel would open. 
- FB905 - fixed timing issue running scopes with AR-CE 
- FB915  - fixed problem in OS Update that would give false-positive to Drive Enabled error 
- FB938  - fixed problem when cancelling FLASH RES will still wait for Reboot recovery 
- FB939 - fixed problem where Echo was left off after using Scopes for AR-CE 
- FB952 - fixed problem in CFC editor where internal connectors were not being saved 
- FB1019  - fixed the alignment of the buttons in the Configuration Wizard 
- FB1027  - changed the legacy PLC bits and numeric status panel labels to ACR_PLC 
- FB1028  - changed the Drive Talk bits and numeric status panel labels to Drive 
- FB1030  - fixed a problem where right-clicking on a rung of the IEC Ladder editor would crash 
- FB1032  - fixed a problem where shift-right-clicking on multiple elements of an IEC ladder editor 

would crash 
- FB1038  - fixed a problem where the legacy ACR PLC toolbar was visible with AR-CE projects 
- FB1039  - fixed a problem where stepper axes may not configure the DEO Servers as Shutdown 

function bit. 
- FB1044  - fixed a problem where changes to the configuration where not be used if the 

configuration had previously been downloaded to the controller 
- FB1045  - fixed a problem where some Online edits would not take effect after a build 
- FB1048  - fixed a problem where some Online edits would not be downloaded after a build 
- FB1052  - fixed a problem with Configuration not setting the proper feedback type for motors 

with 7D/9D feedback 
- FB1063 - fixed a problem with Halt programs if also halting the IEC PLC 
- FB1080  - fixed a problem with IEC Ladder editor where clicking off of a textbox leaves focus 

stuck on that textbox 
- FB1084  - fixed a problem where ACR_PLC dialog titles where missing the PLC number. 
- FB1103  - fixed a problem where opening ACR PLC dialog makes the file marked as changed 
- FB1105  - fixed a problem with the Scaling dialog if the user units are set to counts and drive or 

motor has changed, the scaling factor would not get updated. 
- FB1107  - fixed a problem with the IEC Ladder editor where the Options->Menu Width default 

would be 0 



- FB1114  - fixed a problem with the Scaling dialog if the user units are set to counts and EPL drive 
or motor has changed, the scaling factor would not get updated. 

- FB1171  - fixed a problem where changing the project directory will create extra orphaned 
projects 

- FB1189  - fixed a problem where projects uploaded when line numbers are enabled will corrupt 
the upload 

- FB1249  - fixed a problem with behavior of docking window making the window inaccessible 
 
  

Revision 6.1.2 (2/9/11) 
• Updated license for IEC PLC functionality 
 

 
Revision 6.1.1 (12/23/10) 

• Added features 
- added a feature to allows user to make sure the controller is ready to update the controllers 
operating system. 

- added a feature that detects a failed connection sooner 
- added new tags to Tag Export for the ACR96xx Family of Programmable Automation Controllers 

 
• Fixed miscellaneous bugs 

  - fixed a problem with crashing when opening a project if a project was already opened 
  - fixed a problem with fixed some grammatical errors in certain dialogs 
  - fixed a problem with focus getting stuck on an IEC function block 
  - fixed a problem with Scaling wizard defaulting to Leadscrew for EPL axes with a non-Parker 

linear motor 
  - fixed a problem with projects created in version 6.0.4 and earlier would mistaken some linear 

motors as rotary motors 
  - fixed a problem with projects created in version 6.0.4 and earlier with LXR motors would generate 

a bad configuration file 
  - fixed a problem with projects created in version 6.0.4 and earlier with MPP/9D motors would open 

as an MPP/7D motor 
  - fixed a problem with projects created in version 6.0.4 and earlier with Trilogy motors would open 

with incorrect winding. 
  - fixed a problem where some linear motors are not configured properly if the advanced motor 

parameters dialog is skipped. 
  - fixed a problem were the Bit Status Panel does not recover from a Watchdog event 
  - fixed a problem with crashing in the IEC PLC editors, a direct access variable is declared as an 

invalid datatype. 
  - fixed a problem with projects with Compax3 DAC axes are not opening with the correct motors 

 
Revision 6.1.0 (10/11/10) 

• Added support for the ACR96xx family of Programmable Automation Controllers 
  - includes Ladder Diagram editor 
  - includes Continuous Function Chart editor 
  - includes Structured Text editor 
  - includes library of common ACR function blocks 
 

• Added Export Tags feature to export common ACR tags to InteractX or Xpress 
 

• Added Export data feature in Scopes 
 

• Fixed miscellaneous bugs 



  - fixed a problem with closing projects properly 
  - fixed a problem with downloading EPL OS 
  - fixed a problem with setting the User Defined Part Number for Motors 
  - fixed a problem with EPLD Parameters in the Scopes 
  - fixed a problem with Jog/Home/Limits dialog using USB 
  - fixed a problem with report generation 
  - fixed a problem with downloading programs to AR-CE while programs are running 
  - fixed a problem with uploading programs via Serial or USB 

   
Revision 6.0.5 (8/06/10) 

• Fixed miscellaneous bugs 
  - fixed a problem with opening drive configurations properly 
  - fixed a problem with downloading OS through USB 
  - fixed a problem with the Scaling Wizard with Compax3 EPL and linear motor 
  - disabled the servo gains for Compax3 EPL axes - servo tuning done through C3 

ServoManager 
 
Revision 6.0.4 (6/04/10)  

• Fixed miscellaneous bugs 
  - fixed a problem with PPU not being saved properly 
  - fixed a problem with Drive I/O logic levels being switched 

 
Revision 6.0.3 (4/16/10)  

• Removed option to disable Maximum Position Error for DAC axes 
 
• Fixed miscellaneous bugs 

  - fixed a problem with program editor's indent and outdent buttons 
  - fixed a problem with some dialog titles being too long 
  - fixed a problem with Jog/Teach panel sometimes using incorrect PPU values 
  - fixed a problem with Jog/Home/Limits dialog's generated code for stepper axes 
  - fixed a problem with User Defined Part Numbers not getting uploaded 
  - fixed a problem with downloading programs with errors 
  - fixed a problem with default position feedback 
  - fixed a problem with opening project crashes if there is an extra directory in the project directory 
  - fixed a problem with status panels not updating after a watchdog reconnect event 
  - fixed a problem with ANI feedback option missing 
  - fixed a problem with downloading program files with <tab> characters 
  - fixed a problem with Jog/Home/Limits dialog not configuring SSI feedback properly 
  - fixed a problem with Jog/Home/Limits dialog locking up when using USB communications 
  - fixed a problem with generated System Code for stepper axes 
  - fixed a problem with SSI options are not being loaded when project opens 
  - fixed a problem with certain configuration warning preventing download 
  - fixed a problem with opening projects sometimes crashes 
  - fixed a problem with PPU sometimes not being calculated properly for linear motors 
  - fixed a problem with feedback resolution not being saved properly 
  - fixed a problem with configuration report missing some elements 
  - fixed a problem with defaults for SSI configuration 
  - fixed a problem with removing controller from project 
  - fixed a problem when Aries drive and Trilogy motor is selected for a Stepper axis 
  - fixed a problem with Aries Controller not stopping programs before program download 
  - fixed a problem with User Defined Part Number not retaining part number 
 



Revision 6.0.2 (11/11/09)  
• Updated EPL-related Bits and Parameters 

 
• Added support for the Ethernet/IP Bits and Parameters in the Status Panels 

 
• Fixed miscellaneous bugs 

  - fixed a problem with Scaling not loading properly with multi-master systems 
  - fixed a problem with Servo Tuner not sending gains 
  - fixed a problem with losing Input 0 from the inputs listbox in the Limits dialog 
  - fixed a problem with the editors stripping blank lines 
  - fixed a problem with the communication settings were not being saved 
  - fixed a problem with MPP Motors with Absolute Encoders 
  - fixed a problem with the CANOpen calculator in the CANOpen setup 
  - fixed a problem with EPL Input selection in the Faults setup 
  - fixed a problem dealing with Multiple Masters 
  - fixed a problem with custom scaling 
  - fixed a problem with uploading Program 1 

 
Revision 6.0.1 (09/15/09)  

• Added support in AriesEPL and AR-CE configuration for MPJ motors 
 

• Fixed miscellaneous bugs 
  - fixed a problem scaling for linear motors 
  - fixed a problem with updating EPL-related projects with certain motors 
  - fixed a problem with AR-CE scopes using on-board sample with the servo period 
  - fixed terminal buttons not being saved 
  - fixed loading and saving of encoders and sources 
  - fixed a problem with the communication settings were not being saved 
 
Revision 6.0.0 (06/23/09) 

• Changed the Installation 
  - ACR-View 6.0 and 5.5.5 can reside on the same PC simultaneously 
 

• Changed the Project Tree structure 
  - Assigned all Axis information to a specific Master 
  - Updated the Configuration Wizard 
  - Added a Messages Window to show Status Messages 
 

• ComACRServer made into an executable  
  - Added an AddAlarmEvent Method 
  - Added a DeleteAlarmEvent Method 
  - Added an AlarmEvent Event   
 

• Fixed miscellaneous bugs 
  - fixed a problem with non contiguous Inputs in the Negative and Home Inputs 
  - fixed the ACRViewMotorDatabase to correctly assign Input and Output Types 
  - fixed Scaling rounding problems 
  - fixed a problem retaining the states of selected inputs 
  - fixed loading and saving of encoders and sources 
 
Revision 5.5.5 

• Fixed miscellaneous bugs 



  - fixed Aries CE motor file download not saving DMTR 
  - fixed Aries CE motor file download does not Reboot 
  - fixed Aries CE motor file download now does a faster Drive Reset 
 
Revision 5.5.3 

• Fixed miscellaneous bugs 
• Updated Online Help 

 
Revision 5.5.1 

• Improved communications with the Aries Single Axis Drive/Controller 
• Fixed miscellaneous bugs 

 
Revision 5.5.0 

• Added support for the AriesCE single axis drive-controller 
• Added Common Status Panel 
• Added Jog/Teach Panel 
• Added Playback Panel 
• Updated ACR Communications Server components  
• Fixed miscellaneous bugs 

 
Revision 5.4.0 

• Added support for the ACR9030 and ACR9040 EPL Controller 
• Added configuration for the AriesEPL Digital Servo Drives through the EPL Controller 
• Updated ACR Communications Server components 
• Fixed miscellaneous bugs 
• Updated online Help system with new command supporting EPL.   

 
Revision 5.3.0 

• Added Configuration Code Viewer 
• Settings in the scope tools are now saved 
• Updated ACR Communications Server components 
• Fixed miscellaneous bugs 
• Updated online Help system with new command grouping.  This will replace the View > Programming 

Help Dialog.  The online Help system can be found at Help > User's Guides 

 
Revision 5.2.0 

• Added support for USB communications on ACR9000 (requires ACR firmware 1.18.17 or greater) 
• Added support for Analog Input daughter card on ACR9000 (requires ACR firmware 1.18.17 or greater) 
• Updated ACR Communications Server components 
• Fixed miscellaneous bugs 
• Updated online Help system 

 
Revision 5.1.0 

• Added support for end-of-travel limits and home input in Configuration Wizard (requires ACR firmware 
1.18.15 or greater) 

• Added mini ServoTuner to Configuration Wizard (requires ACR firmware 1.18.15 or greater) 
• Added commissioning screen (Jog/Home/Limits) to Configuration Wizard (requires ACR firmware 

1.18.15 or greater) 



• Updated ACR Communications Server components 
• Fixed miscellaneous bugs 
• Updated online Help system 

 
Revision 5.0.3 

• Includes New ACR Communication Server  
 

Revision 5.0.2 
• Improved Ethernet communications (requires ACR firmware 1.18.12 Update 12 or greater) 
• Fixed miscellaneous bugs 
• Updated online ACR Users Guide, version 1.2.2 

 

Revision 5.0.1 
• Fixed bug regarding deleting PBOOT from PLC programs 
• Added a New Style function block TM to replace TIM in the PLC program editor 
• Updated Help system to include New Style function blocks and some Lineless programming commands 

 

Revision 5.0.0 
• Initial release with full support for the ACR Family 

  *Note:  The PLC editor uses the New Style function blocks listed below: 
    - CTD replaces CNT 
    - LAT replaces KR 

These New Style function blocks are also now considered operators and can be followed by 
coils or contacts. 
In order to use the New Style function blocks, firmware version 1.18.12 or higher is 
required. 
The PLC Editors enforces that each rung end with at least one contact. 
 
Lineless Programming is encouraged: 
 - PROGRAM initiates the program definition 
 - ENDP ends the program definition 

 

 


